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ABSTRAK

ARFIANI GUSFIRA. Analisis Tingkat Konsentrasi Total Suspended Particulate
(TSP) pada Ruas Jalan Letjen Hertasning (dibimbing oleh Ir. Nurul Masyiah Rani
Harusi, S.T., M.Eng)

Latar Belakang. Meningkatnya jumlah kendaraan bermotor setiap tahun
telah menjadi salah satu penyebab utama pencemaran udara, terutama peningkatan
konsentrasi Total Suspended Particulate (TSP) di udara. Selain kendaraan bermotor,
konsentrasi TSP juga dipengaruhi oleh faktor-faktor meteorologi. Paparan TSP dapat
mengakibatkan berbagai masalah kesehatan bagi masyarakat, termasuk gangguan
pernapasan seperti asma, penyakit jantung, dan penyakit paru-paru obstruktif kronis.
Tujuan. Penelitian ini bertujuan untuk menganalisis tingkat konsentrasi TSP di udara
ambien di ruas Jalan Letjen Hertasning. Selain itu, juga bertujuan untuk mengetahui
hubungan antara konsentrasi TSP dan volume kendaraan, serta menganalisis
pengaruh faktor meteorologi terhadap konsentrasi TSP pada ruas Jalan Letjen
Hertasning. Metode. Penelitian ini menggunakan alat High Volume Air Sampler
(HVAS) untuk pengambilan sampel di 9 titik, disertai dengan pengukuran volume
kendaraan dan faktor meteorologi. Setelah itu dilakukan uji korelasi untuk
mengetahui hubungan antara tingkat konsentrasi TSP dengan volume kendaraan
dan hubungan antara tingkat konsentrasi TSP dengan data metereologi. Hasil.
Konsentrasi TSP tertinggi berada pada titik 9 interval sore yaitu sebesar 1386 ug/me.
Konsentrasi TSP terendah berada pada titik 4 interval pagi sebesar 38,68 ug/m3. Uji
korelasi menunjukkan bahwa ada hubungan signifikan antara konsentrasi TSP dan
volume kendaraan, dengan nilai signifikansi <0,05. Namun, tidak ada hubungan
signifikan antara konsentrasi TSP dan faktor meteorologi, dengan nilai signifikansi
>0,05, menunjukkan bahwa faktor meteorologi tidak memengaruhi tingkat
konsentrasi TSP. Kesimpulan. Berdasarkan Peraturan Pemerintah Nomor 22 Tahun
2021 tentang Penyelenggaraan Perlindungan dan Pengelolaan Lingkungan Hidup
hasil pengukuran menunjukkan bahwa pada titik 9 melebihi baku mutu sedangkan
pada titik 4 tidak melebihi baku mutu dengan nilai baku mutu 230 ug/m3.Volume
kendaraan berpengaruh terhadap tingkat konsentrasi TSP sedangkan untuk faktor
metereologi tidak berpengaruh terhadap tingkat konsentrasi TSP.

Kata Kunci: Volume Kendaraan, Faktor Meteorologi, Total Suspended Particulate
(TSP), Korelasi.
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ABSTRACT
ARFIANI GUSFIRA. Analysis of Total Suspended Particulate (TSP)
Concentration Levels on Letjen Hertasning Road (supervised by Ir. Nurul Masyiah
Rani Harusi, S.T., M.Eng)

Background. The increasing number of motorized vehicles every year has
become one of the main causes of air pollution, especially the increase in the
concentration of Total Suspended Particulate (TSP) in the air. Apart from motorized
vehicles, TSP concentrations are also influenced by meteorological factors. Exposure
to TSP can cause various health problems for people, including respiratory problems
such as asthma, heart disease, and chronic obstructive pulmonary disease.
Objective. This research aims to analyze the level of TSP concentration in the
ambient air on Jalan Letjen Hertasning. Apart from that, it also aims to determine the
relationship between TSP concentration and vehicle volume, as well as analyzing the
influence of meteorological factors on TSP concentration on Jalan Letjen Hertasning.
Method. This research uses a High Volume Air Sampler (HVAS) tool for sampling at
9 points, accompanied by measurements of vehicle volume and meteorological
factors. After that, a correlation test was carried out to determine the relationship
between TSP concentration levels and vehicle volume and the relationship between
TSP concentration levels and meteorological data. Results. The highest TSP
concentration was at point 9 of the afternoon interval, namely 1386 ug/m3. The lowest
TSP concentration was at point 4 of the morning interval at 38.68 ug/m3. The
correlation test shows that there is a significant relationship between TSP
concentration and vehicle volume, with a significance value of <0.05. However, there
was no significant relationship between TSP concentration and meteorological
factors, with a significance value >0.05, indicating that meteorological factors did not
influence TSP concentration levels. Conclusion. Based on Government Regulation
Number 22 of 2021 concerning the Implementation of Environmental Protection and
Management, the measurement results show that at point 9 it exceeds the quality
standard, while at point 4 it does not exceed the quality standard with a quality
standard value of 230 ug/m3. Vehicle volume influences the TSP concentration level,
whereas for Meteorological factors have no effect on TSP concentration levels.

Keywords: Vehicle Volume; Meteorological Factors; Total Suspended Particulate
(TSP), Correlation.
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BAB |
PENDAHULUAN
1.1 Latar Belakang

Berdasarkan Peraturan Pemerintah No0.22 tahun 2021 tentang
Penyelenggaraan dan Pengelolaan Lingkungan Hidup, pencemaran udara
merupakan masuknya atau terserapnya zat, energi, atau zat lain kedalam udara
ambien oleh kegiatan manusia, sehingga mengakibatkan penurunan kualitas
udara yang di sekitarnya pada tingkat tertentu, yang menyebabkan udara tidak
memenuhi fungsinya. Sumber pencemaran udara dapat terjadi secara alamiah
maupun akibat aktivitas manusia (sumber antropogetik), seperti kendaraan
bermotor dan pembakaran biomasa.

Polusi udara merupakan masalah yang dihadapi baik oleh negara
berkembang maupun negara maju. Menurut WHO (2019), lebih dari 90%
penduduk di negara-negara berkembang tinggal di lingkungan dengan kualitas
udara yang tidak sehat untuk bernafas. Kondisi ini menjadi salah satu penyebab
terjadinya sekitar 4,2 juta kematian setiap tahunnya. Berdasarkan penelitian
yang dilakukan oleh Japan Internatioal Cooperation Agency (JICA) bahwa sektor
transportasi diperkirakan menyumbangkan 70 - 83 % pencemaran udara di
daerah perkotaan (Oktaviani, 2018).

Salah satu metode untuk mengetahui kualitas udara di suatu area atau
lingkungan adalah dengan mengukur dan melakukan pemantauan konsentrasi
parameter yang terdapat dalam udara tersebut. Berdasarkan Peraturan
Pemerintah Republik Indonesia No. 22 Tahun 2021 ada beberapa parameter
baku mutu kualitas udara, salah satunya adalah Total Suspended Particulate
(TSP). TSP adalah partikel yang terdiri dari campuran berbagai elemen dan
senyawa dengan ukuran partikel yang bervariasi, mulai dari yang sangat kecil
hingga sekitar ukuran 100 mikron. Akibat dari paparan TSP yaitu masyarakat
dapat berisiko mengalami gangguan kesehatan pernafasan seperti ISPA, asma,
efisema, penyakit jantung dan penyakit paru-paru obstruktif kronis (Nurfadillah
dan Basri, 2023).

Kota Makassar merupakan salah satu kota metropolitan yang ada di
Indonesia dengan peningkatan jumlah kendaraan yang cukup pesat. Jumlah
volume kendaraan di Kota Makassar telah mencapai 2,1 juta unit kendaraan,
dengan pertumbuhan kendaraan roda dua meningkat sebesar 14% per tahun
dan roda empat meningkat sebesar 10% per tahun (Zakariah dkk., 2021). Salah
satu jalan yang banyak dilalui oleh kendaraan adalah jalan Letjen Hertasning.
Ruas Jalan Letjen Hertasning Kota Makassar merupakan tipe jalan dua arah dan
terbagi oleh median. Ruas jalan Letjen Hertasning menjadi akses ke pusat
perbelanjaan, perhotelan dan juga perkantoran sehingga memiliki volume lalu
lintas yang relatif tinggi. Selain itu, ruas Jalan Letjen Hertasning juga merupakan
jalan provinsi yang menghubungkan antara kota Makassar dengan kabupaten
Gowa. Berdasarkan survei pendahuluan volume kendaraan di Jalan Letjen
Hertasning tanggal 27 Juli 2024 pukul 12.00 — 13.00 WITA sepeda motor



sebanyak 2986 unit/jam, kendaraan ringan sebanyak 1283 unit/jam, kendaraan
berat sebanyak 76 unit/jam. Volume kendaraan yang banyak ini memungkinkan
tingginya konsentrasi TSP di jalan Letjen Hertasning. Tingginya tingkat
konsentrasi TSP juga dapat dipengaruhi oleh faktor-faktor metereologi. Faktor
meteorologi yang berpengaruh langsung terhadap penyebaran polutan adalah
angin serta stabilitas atmosfer. Radiasi tidak secara langsung mempengaruhi
dispersi, tetapi mempengaruhi fluktuasi suhu dan tekanan yang akan
mempengaruhi angin dan stabilitas atmosfer (Turyanti, 2011).

Berdasarkan Peraturan Pemerintah Republik Indonesia Nomor 22 Tahun
2021 tentang Penyelenggaraan dan Pengelolaan Lingkungan Hidup, beberapa
pengertian yang berkaitan dengan kegiatan pemantauan kualitas udara,
diantaranya adalah mengenai batas — batas ambien maksimal yang berada di
udara. Batas maksimal yang telah ditentukan adalah batas dimana suatu polutan
akan berdampak negatif bagi lingkungan, sehingga suatu kota akan dapat
dikatakan tercemar oleh suatu senyawa polutan apabila telah melewati batas
tersebut. Berdasarkan latar belakang tersebut, maka perlu dilakukan kajian
penelitian terkait “Analisis Tingkat Konsentrasi Total Suspended Particulate
(TSP) pada Ruas Jalan Letjen Hertasning” untuk mengetahui tingkat konsentrasi
TSP di ruas Jalan Letjen Hertasning.

1.2 Rumusan Masalah

Adapun rumusan masalah dari penelitian ini sebagai berikut:

a. Berapa besar tingkat konsentrasi Total Suspended Particulate (TSP) udara
ambien pada ruas Jalan Letjen Hertasning?

b. Bagaimana hubungan konsentrasi Total Suspended Particulate (TSP)
dengan volume kendaraan pada ruas Jalan Letjen Hertasning?

c. Bagaimana hubungan konsentrasi Total Suspended Particulate (TSP)
dengan faktor metereologi pada ruas Jalan Letjen Hertasning?

1.3 Tujuan Penelitian

Adapun tujuan penelitian ini sebagai berikut:

a. Menganalisis tingkat konsentrasi konsentrasi Total Suspended Particulate
(TSP) udara ambien pada ruas Jalan Letjen Hertasning.

b. Menganalisis hubungan konsentrasi Total Suspended Particulate (TSP)
dengan volume kendaraan pada ruas Jalan Letjen Hertasning.

c. Menganlisis hubungan konsentrasi Total Suspended Particulate (TSP)
dengan faktor metereologi pada ruas Jalan Letjen Hertasning.



1.4 Manfaat Penelitian

Adapun manfaat penelitian ini sebagai berikut:

a.

Bagi Penulis

Untuk memenuhi syarat untuk menyelesaikan studi dan mendapat gelar ST
(Sarjana Teknik) di Departemen Teknik Lingkungan Fakultas Teknik
Universitas Hasanuddin

Bagi Universitas.

Dapat digunakan sebagai referensi pada penelitian selanjutnya dalam
bidang kualitas udara terutama parameter Total Suspended Particulate
(TSP) pada ruas jalan Letjen Hertasning Kota Makassar.

Dapat memberikan pengetahuan pada masyarakat mengenai tingkat
konsentrasi Total Suspended Particulate udara ambien pada ruas jalan
Letjen Hertasning.

Bagi Pemerintah

Menjadi informasi bagi pihak pemerintah tentang tingkat konsentrasi Total
Suspended Particulate (TSP) udara ambien pada ruas jalan Letjen
Hertasning Kota Makassar.

1.5 Ruang Lingkup

Adapun ruang lingkup penelitian ini sebagai berikut:

a. Parameter pencemar yang digunakan dalam penelitian ini adalah Total
Suspended Particulate (TSP).

b. Lokasi penelitian ini dilakukan di ruas jalan Letjen Hertasning dengan titik
penelitian berjumlah 9 titik.

c. Penelitian dilaksanakan selama 3 hari pada tanggal 31 Juli 2024, 1 Agustus
2024 dan 5 Agustus 2024.

d. Data metereologi meliputi kecepatan angin, kelembaban, suhu udara dan
tekanan atmosfer.

1.6 Teori

1.6.1 Udara Ambien

Udara merupakan campuran beberapa macam gas yang perbandingannya

tidak tetap, tergantung pada keadaan suhu udara, tekanan udara dan
lingkungannya. Gas-gas lain yang terdapat dalam udara antara lain gas-gas
mulia, nitrogen oksida, hidrogen, metana belerang oksida, amonia dan lain-lain.
Apabila susunan udara mengalami perubahan dari susunan normal seperti
tersebut di atas dan kemudian menggangu kehidupan manusia, hewan,
tumbuhan, bangunan gedung, dan lain sebagainya maka berarti udara telah
tercemar (Hartono, 2020).

Udara dapat digolongkan menjadi dua, yaitu udara ambien dan udara

emisi. Udara ambien merupakan udara bebas di permukaan bumi pada lapisan



troposfir yang dibutuhkan dan mempengaruhi kesehatan manusia, makhluk

hidup dan unsur lingkungan hidup lainnya. Sedangkan udara emisi merupakan

udara yang dikeluarkan langsung dari sumber emisi seperti knalpot kendaraan
bermotor dan cerobong gas buang pabrik. Udara termasuk dalam salah satu
sumber daya alam non hayati di dalam ekosistem yang mempunyai hubungan

timbal balik dengan makhluk hidup (Anjarsari, 2019).

Berdasarkan Peraturan Pemerintah Republik Indonesia Nomor 22 Tahun
2021 tentang Penyelenggaraan dan Pengelolaan Lingkungan Hidup, udara
ambien adalah udara bebas dipermukaan bumi pada lapisan troposfir yang
berada di dalam wilayah yurisdiksi Republik Indonesia yang dibutuhkan dan
berpengaruh terhadap kesehatan manusia.

Berdasarkan SNI 19-7119.6-2005 tentang Udara Ambien. Prinsip
pengambilan contoh uji kualitas udara ambien harus memenubhi kriteria berikut:
a) Area dengan konsentrasi pencemar tinggi. Daerah yang didahulukan

untuk dipantau hendaknya daerah-daerah dengan konsentrasi pencemar
yang tinggi. Satu atau lebih stasiun pemantau mungkin dibutuhkan di
sekitar daerah yang emisinya besar.

b) Area dengan kepadatan penduduk tinggi. Daerah-daerah dengan
kepadatan penduduk yang tinggi, terutama ketika terjadi pencemaran
yang berat.

C) Di daerah sekitar lokasi penelitian yang diperuntukkan untuk kawasan
studi maka stasiun pengambil contoh uji perlu ditempatkan di sekeliling
daerah/kawasan.

d) Di daerah proyeksi. Untuk menentukan efek akibat perkembangan
mendatang di lingkungannya, stasiun perlu juga ditempatkan di daerah-
daerah yang diproyeksikan.

e) Mewakili seluruh wilayah studi. Informasi kualitas udara di seluruh wilayah
studi harus diperoleh agar kualitas udara di seluruh wilayah dapat
dipantau (dievaluasi).

1.6.2 Pencemaran Udara

1. Pengertian

Menurut Peraturan Pemerintah Republik Indonesia Nomor 22 Tahun
2021 tentang Penyelenggaraan dan Pengelolaan Lingkungan Hidup,
pencemaran udara adalah masuknya atau dimasukkannya zat, energi dan
atau komponen lainnya ke dalam udara ambien oleh kegiatan manusia
sehingga melampaui Baku Mutu Udara Ambien yang telah ditetapkan.
Menurut Abdullah (2018), pencemaran udara adalah bertambahnya bahan
atau substrat fisik atau kimia ke dalam lingkungan normal yang mencapai
sejumlah tertentu, sehingga dapat dideteksi oleh manusia (atau yang dapat
dihitung dan diukur) serta dapat memberikan efek pada manusia, binatang,
vegetasi dan mineral.



Udara yang telah terkontaminasi zat pencemar disebut udara
tercemar yang dapat merusak lingkungan dan kehidupan manusia.
Pencemaran udara semakin memburuk seiring dengan kemajuan
teknologi, dimana dengan kemajuan teknologi sehingga sumber penghasil
polusi udara semakin meningkat (Abidin dan Hasibuan, 2019).

Sumber pencemaran udara dapat dibagi menjadi 3 yaitu: (1) sumber
perkotaan dan industri; (2) sumber pedesaan/pertanian; (3) sumber alami.
Sumber perkotaan dan industri berasal dari kemajuan teknologi yang
mengakibatkan banyaknya pabrik-pabrik industri, pembangkit listrik dan
kendaraan bermotor. Sumber pencemaran udara untuk wilayah
pedesaan/pertanian yaitu dengan penggunaan pestisida sebagai zat
senyawa kimia (zat pengatur tumbuh dan perangsang tumbuh), virus dan
zat lain-lain yang digunakan untuk melakukan perlindungan tanaman atau
bagian tanaman. Sedangkan sumber alami berasal dari alam seperti abu
yang dikeluarkan akibat gunung berapi, gas-gas vulkanik, debu yang
bertiupan akibat tiupan angin, bau yang tidak enak akibat proses
pembusukan sampah organik dan lainnya.

Jenis-Jenis Pencemaran Udara
Menurut Abdullah (2018), ada beberapa jenis pencemaran udara, yaitu:
a. Berdasarkan Bentuk

1. Gas, adalah uap yang dihasilkan dari zat padat atau zat cair
karena dipanaskan atau menguap sendiri. Contohnya: CO2, CO,
SOx, NOx.

2. Partikel, adalah suatu bentuk pencemaran udara yang berasal
dari zarah - zarah kecil yang terdispersi ke udara, baik berupa
padatan, cairan, maupun padatan dan cairan secara bersama -
sama. Contohnya: debu, asap, kabut, dan lain - lain.

b. Berdasarkan Tempat

1. Pencemaran udara dalam ruang (indoor air pollution) yang
disebut juga udara tidak bebas seperti di rumah, pabrik, bioskop,
sekolah, rumah sakit, dan bangunan lainnya. Biasanya zat
pencemarnya adalah asap rokok, asap yang terjadi di dapur
tradisional ketika memasak, dan lain - lain.

2. Pencemaran udara luar ruang (outdoor air pollution) yang disebut
juga udara bebas seperti asap asap dari industri maupun
kendaraan bermotor.

c. Berdasarkan Gangguan atau Efeknya Terhadap Kesehatan

1. Irritansia, adalah zat pencemar yang dapat menimbulkan iritasi
jaringan tubuh, seperti SO2, Ozon, dan Nitrogen Oksida.

2.  Aspeksia, adalah keadaan dimana darah kekurangan oksigen
dan tidak mampu melepas Karbon Dioksida. Gas penyebab
tersebut seperti CO, H2S, NHs, dan CHa.

3. Anestesia, adalah zat yang mempunyai efek membius dan
biasanya merupakan pencemaran udara dalam ruang.



Contohnya; Formaldehide dan Alkohol.
4. Toksis, adalah zat pencemar yang menyebabkan keracunan. Zat
penyebabnya seperti Timbal, Cadmium, Fluor, dan Insektisida.
d. Berdasarkan Susunan Kimia
1. Anorganik, adalah zat pencemar yang tidak mengandung karbon
seperti asbestos, amonia, asam sulfat, dan lain - lain.
2. Organik, adalah zat pencemar yang mengandung karbon seperti
pestisida, herbisida, beberapa jenis alkohol, dan lain — lain.
e. Berdasarkan asalnya
1. Primer, adalah suatu bahan kimia yang ditambahkan langsung ke
udara yang menyebabkan konsentrasinya meningkat dan
membahayakan. Contohnya: CO2, yang meningkat diatas
konsentrasi normal.
2.  Sekunder, adalah senyawa kimia berbahaya yang timbul dari
hasil reaksi antara zat polutan primer dengan komponen alamiah.
Contohnya: Peroxy Acetil Nitrat (PAN).

1.6.3 Faktor-Faktor Dispersi Polutan

Menurut Aly dkk (2018), dispersi adalah proses perpindahan, difusi, reaksi

kimia dan pengankutan polutan yang telah diemisikan ke udara oleh atmosfer.
Dispersi polutan tidak hanya dipengaruhi oleh banyaknya jumlah kendaraan
yang lewat namun juga faktor lain, yaitu faktor-faktor meteorologis juga sangat
mempengaruhi proses dispersi polutan. Faktor-faktor tersebut antara lain:

a.

Temperatur Udara

Semakin tinggi suhu udara konsentrasi pencemar akan semakin rendah.
Hal ini disebabkan pada suhu udara tinggi, densitas udara di permukaan
bumi akan menjadi lebih rendah daripada udara diatasnya sehingga
menyebabkan terjadinya aliran konveksi keatas membawa berbagai
polutan dan menyebabkan konsentrasi polutan menjadi lebih rendah.
Sehingga semakin rendah suhu udara kadar pencemar juga akan
meningkat (llham, 2021).

Kelembaban

Semakin tinggi kelembaban maka konsentrasi pencemar akan semakin
tinggi. Hal tersebut disebabkan karena pada kondisi kelembaban tinggi,
dispersi gas pencemar akan terhambat. Hal ini terjadi karena terbentuknya
lapisan udara dingin yang menyebabkan terjadinya akumulasi gas
pencemar sehingga dispersi pencemar atau polutan akan terhambat. Pada
udara yang lebih lembab polutan sulit untuk berpindah ke atmosfer dan
susah untuk terencerkan sehingga pada kondisi ini kadar pencemar akan
meningkat saat kelembaban dipermukaan tinggi (Ilham, 2021).

Tekanan Udara

Dengan keadaan tekanan udara yang tinggi akan menyebabkan polutan
udara yang berukuran kecil akan terdispersi. Sedangkan pada tekanan



yang rendah, polutan dengan ukuran yang cukup besar akan sulit
terdipersi. Stabilitas atmosfer mempengaruhi sebaran polutan. Semakin
stabil atmosfer maka polutan akan terdispersi lebih jauh, sebaliknya jika
atmosfer semakin tidak stabil maka polutan terdispersi semakin dekat
dengan sumber polutan (Aslim dkk, 2019).
d. Kecepatan Angin

Kecepatan angin yang tinggi akan mempengaruhi cepatnya penyebaran
emisi dari sumber ke lingkungan sehingga polutan yang terdispersi
mengalami pengenceran dan kadar polutan menjadi lebih rendah. Semakin
tinggi kecepatan angin, maka konsentrasi poluan akan semakin kecil
karena polutan terbawa angin menjauhi lokasi pengukuran dan pencemar
akan terdilusi melalui dispersi sehingga tidak akan terkonsentrasi di lokasi
tertentu) (Ilham, 2021).

1.6.4 Baku Mutu Udara Ambien

Menurut Peraturan Pemerintah Republik Indonesia Nomor 22 Tahun 2021
tentang Penyelenggaraan dan Pengelolaan Lingkungan Hidup, Baku Mutu
Udara Ambien adalah ukuran batas atau kadar zat, energi, dan/atau komponen
yang ada atau yang seharusnya ada dan/atau unsur pencemar yang ditenggang
keberadaannya dalam udara ambien. Udara yang melebihi baku mutu dapat
merusak lingkungan sekitarnya dan berpotensi mengganggu kesehatan
masyarakat. Arah dan tujuan dari penetapan baku mutu udara ambien nasional
adalah untuk mencegah pencemaran udara. Baku mutu udara ambien dapat
kita lihat pada tabel di bawah ini:

Tabel 1. Baku Mutu Udara Ambien

No. Parameter Waldu Baku Mutu Sistem
Pengukuran Pengukuran
1 iam 150 pg/m?® Aktif kontinu
. SOz (Sulfur 5 4J.am Aktif manual
Dioksida T ; oo 75 pg/m? Aktif kontinu
45 ug/m?® Aktif kontinu
5 CO (Karbon 1 Jam 1000 pg/md Aktif kontinu
Monoksida) 8 Jam 4000 pg/m?3 Aktif kontinu
1 Jam 200 pg/Nm?® Aktif kontinu
3 NO:2 (Nitrogen Aktif manual
Dioksida 24 Jam 65 pug/Nm? Aktif kontinu
1 Tahun 50 pug/Nm? Aktif kontinu

3 . .
Oksigen Fotokimia 1 Jam 150 pg/Nm 2::::: Ir(noanr?lT:I
4 (C())X) sebagal Ozon 8 jam 100 Aktif kontinu
3 1 Tahun 35 ug/Nm? Aktif kontinu
5 Hidrokarbon Non 3 Jam 160 pg/Nm? Aktif kontinu

Metana (NMHC)




No. Parameter Walktu Baku Mutu Sistem
Pengukuran Pengukuran
Partikulat debu 24 Jam 230 ug/m?® Aktif manual
<100 ysm (TSP)
6 Partikel <10 psm 24 Jam 75 ug/m?® Aktif kontinu
(PM10) Aktif manual
1 tahun 40 pg/m3 Aktif kontinu
: 24 Jam 55 ug/m?® Aktif kontinu
I(Dl:?l\r/ltlzi(;l <2,5 yusm Aktif manual
’ 1 Tahun 15 yg/m?3 Aktif kontinu
7 Timbal (Pb) 24 Jam 2 ug/md Aktif manual

Sumber: PP 22 Tahun 2021 tentang Penyelenggaraan Perlindungan dan Pengelolaan
Lingkungan Hidup

1.6.5 Polutan Total Suspended Particulate (TSP)

Total Suspended Particulate (TSP) merupakan partikel-patikel yang
disebabkan oleh penghancuran, pelembutan, pengolahan, pengepakan dan
lain-lain dari bahan-bahan organik maupun anorganik, misalnya batu, biji logam,
arang batu, kayu, butir-butir zat padat dan sebagainya. TSP merupakan partikel
dengan diameter kurang dari 100 ym. TSP umumnya berasal dari gabungan
secara mekanik dan material yang berukuran kasar yang berada di udara, dalam
konsentrasi tertentu dapat berbahaya bagi manusia. Partikulat merupakan
partikulat-partikulat kecil padatan seperti debu dan droplet cairan misalnya
kabut. Beberapa partikulat dalam berbagai bentuk dapat melayang di udara
(Afidah, 2019).

Menurut Sari (2018) dalam Safira (2022), partikulat dapat dikelompokkan
berdasarkan ukurannya menjadi dua kategori: partikulat kasar dan partikulat
halus. Secara umum, ukuran batas antara keduanya adalah 2,5 pum. Partikulat
kasar mencakup partikel dengan ukuran 22,5 ym, sedangkan partikulat halus
terdiri dari partikel dengan ukuran <2,5 uym. Karakteristik partikulat ini dapat
dipengaruhi oleh berbagai faktor, termasuk sumber emisi, kondisi iklim seperti
curah hujan dan kecepatan angin, proses industri, dan aktivitas di lingkungan
udara. Faktor-faktor ini mempengaruhi komposisi material partikel, ukurannya,
serta tingkat toksisitasnya.

Bahan-bahan partikel atau debu merupakan bahan-bahan kompleks dan
campuran yang terdiri dari partikel-partikel dasar karbon (carbon based
particles), debu (dust), dan aerosol asam (acid aerosol). Menurut Yulianto
(2020), secara fisik, debu dan partikel dikategorikan sebagai polutan dalam
bentuk aerosol udara. Debu yang terdiri dari elemen-elemen padat dapat dibagi
menjadi tiga jenis:

1. Debu atau serbuk (dust) dapat bervariasi dari ukuran submikroskopik
hingga yang lebih besar. Debu dengan ukuran kurang dari 100 mikron
umumnya dianggap berbahaya karena dapat dihirup ke dalam sistem
pernapasan dan mencapai organ paru-paru.



Uap (fumes) adalah partikel padat yang dihasilkan dari proses evaporasi
atau pemanasan logam, di mana uap logam mengembun menjadi partikel-
partikel uap logam. Contoh logam yang menghasilkan uap seperti ini
termasuk kadmium dan timbal (Pb).

Asap (smoke) adalah hasil dari pembakaran yang tidak sempurna, dengan
ukuran partikel sekitar 0,5 mikron.

Berdasarkan SNI 7119-3:2017 tentang Cara uji partikel tersuspensi total

menggunakan peralatan menggunakan High Volume Air Sampler (HVAS)
dengan metode gravimetri pengambilan contoh uji dilakukan dengan tahapan
sebagai berikut:

a)

b)
<)

d)

tempatkan alat uji di posisi dan lokasi pengukuran menurut metode
penentuan lokasi pengambilan contoh uji pemantauan kualitas udara
ambien sesuai SNI 19-7119.6

tempatkan filter pada filter holder

hubungkan alat HVAS dengan sumber catu daya. Hidupkan alat pengambil
contoh uji selama 24 jam = 1 jam, pantau dan catat laju alir udara serta
temperatur setiap jam, pastikan laju alir udara berada pada rentang 1,1 m3
/menit sampai dengan 1,7 m*menit. Catat lokasi, tanggal, waktu, dan
tekanan barometer.

matikan alat HVAS, pindahkan filter secara hati-hati, jaga agar tidak ada
partikel yang terlepas. Lipat filter dengan posisi contoh uji berada di bagian
dalam lipatan. Simpan filter tersebut ke dalam wadah penyimpan filter dan
beri identitas.

Selain itu, persyaratan pemilihan lokasi juga harus sesuai dengan kriteria

SNI 19-7119.9-2005 tentang penentuan lokasi pengambilan contoh uiji
pemantauan kualitas udara roadside. Berikut beberapa petunjuk yang dapat
digunakan dalam pemilihan titik pengambilan contoh uji adalah:

a)
b)
<)

d)

e)

f)

pilih lokasi pengambilan contoh uji di stasiun roadside.

tempatkan alat pengambilan contoh uji yang alirannya bebas.

tempatkan alat pengambil contoh uji pada lokasi yang tidak terpengaruh
oleh peristiwa adsoprsi maupun absorpsi.

tempatkan alat pengambilan contoh uji di tempat yang aman yang bebas
dari pengganggu fisika.

hindari daerah yang rawan kerusuhan, bencana alam seperti banjir
perhatikan tipe jalan (lebar, sempit, canyon atau jalan tol, demikian juga
persimpangan jalan, perhentian kendaraan).

1.6.6 Klasifikasi Kendaraan

Ada beberapa klasifikasi kendaraan bermotor, antara lain (Pratomo, 2018) :
1.

Kendaraan berat/Heavy Vehicle (HV) adalah kendaraan bermotor dengan
lebih dari 4 roda meliputi bus, truk, truk 2 as, truk 3 as, dan truk kombinasi.
Kendaraan ringan/Light Vehicle (LV) adalah kendaraan bermotor dengan
empat roda dan dengan jarak as 2,0-3,0 m. Kendaraan ini meliputi mobil
penumpang, microbus, pick up, truk kecil.
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4,
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Sepeda Motor (Motorcycle) adalah kendaraan bermotor dengan 2 atau 3
roda, meliputi sepeda motor dan kendaraan roda 3.

Kendaraan tak bermotor (Unmotorcycle) adalah kendaraan dengan roda
yang digerakkan oleh manusia atau hewan, meliputi sepeda, becak, kereta
kuda, dan kereta.

1.6.7 Klasifikasi Jalan

Berdasarkan Kementerian Pekerjaan Umum dan Perumahan Rakyat

Direktorat Jenderal Bina Marga tahun 2022, klasifikasi jalan berdasarkan sistem
jaringan jalan sebagai berikut:

1.

Jalan arteri, merupakan jalan umum yang berfungsi melayani angkutan
utama dengan ciri perjalanan jarak jauh, kecepatan rata-rata tinggi, dan
jumlah jalan masuk dibatasi secara berdaya guna

Jalan kolektor, merupakan jalan umum yang berfungsi melayani angkutan
pengumpul atau pembagi dengan ciri perjalanan jarak sedang, kecepatan
rata-rata sedang, dan jumlah jalan masuk dibatasi.

Jalan lokal, merupakan jalan umum yang berfungs melayani angkutan
setempat dengan ciri perjalanan jarak dekat, kecepatan rata-rata rendah dan
jumlah jalan masuk tidak dibatasi.

Jalan lingkungan, merupakan jalan umum yang berfungsi melayani angkutan
lingkungan dengan ciri perjalanan jarak dekat, dan kecepatan rata-rata
rendah.

Selain itu klasifikasi jalan juga dikelompokkan berdasarkan status jalan

sebagai berikut:

1.

Jalan nasional, merupakan jalan arteri dan kolektor dalam sistem jaringan
jalan primer yang mengubungkan antar ibukota provinsi, dan jalan strategis
nasional, serta jalan tol.

Jalan provinsi, merupakan jalan kolektor dalam sistem jaringan jalan primer
yang menghubungkan ibukota provinsi dengan ibukota kabupaten/kota, atau
antar ibukota kabupaten/kota, dan jalan strategis provinsi.

Jalan kabupaten, merupakan jalan lokal dalam sistem jaringan jalan primer
yang menghubungkan ibukota kabupaten dengan ibukota kecamatan, antar
ibukota kecamatan, ibukota kabupaten dengan pusat kegiatan lokal, serta
jalan umum dalam sistem jaringan jalan sekunder dalam wilayah kabupaten,
dan jalan strategis kabupaten.

Jalan kota, merupakan jalan umum dalam sistem jaringan jalan sekunder
yang menghubungkan antar pusat pelayanan dalam kota, menghubungkan
pusat pelayanan dengan persil, menghubungkan antar persil, serta
menghubungkan antar pusat permukiman yang berada di dalam kota.

Jalan desa, Merupakan jalan umum yang menghubungkan kawasan
dan/atau antar permukiman di dalam desa serta jalan lingkungan.
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1.6.8 Perhitungan Konsentrasi TSP

Total Suspended Particulate (TSP) yang umumnya berasal dari gas buang
kendaraan bermotor. Berdasarkan SNI 7119-3:2017 dapat dihitung
konsentrasinya dalam pug/Nm? dapat dengan persamaan (1):

1. Koreksi laju alir pada kondisi standar
Koreksi laju alir pada kondisi standar dapat dihitung menggunakan
persamaan (1):

1

= TS X P02 o 1
Qs QOX [T—]OXPS ( )
Keterangan:
Qs = laju alir volume dikoreksi pada kondisi standar (Nm3/menit)
Qo = Laju alir volume uji (m*/menit)
Ts = Temperatur standar, 298 K
To = Temperatur rata-rata aktual (273 + Tukur) dimana Qo ditentukan
Ps = Tekanan barometrik standar, 101,3 kPa (760 mmHQ)
Po = Tekanan barometrik rata-rata aktual dimana Qo ditentukan

2. Volume udara yang diambil
Volume udara yang diambil dapat dihitung menggunakan persamaan (2):

n

V — 2521 QS X T 2

T (2)
Keterangan:
\Y = volume udara yang diambil (mq)
Qs = Laju alir volume dikoreksi pada kondisi standar ke-s (m3/menit)
T = durasi pengambilan contoh uji (menit)
n = Jumlah pecatatan laju reaksi

3. Perhitungan Konsentrasi TSP di Udara Ambien
Perhitungan Konsentrasi TSP dapat digunakan persamaan (3):

C = W2ZTWDX10° e ©)
Vstd

neweraliyail.

C = Konsentrasi massa partikel tersuspensi (ug/m?®)
W1 = Berat filter awal (g)

W2 = Berat filter akhir (g)

Vstd= Volume contoh uji udara dalam keadaan standar (m®)

10% = Konversi gram (g) ke mikrogram (ug).

Nilai konsentrasi hasil perhitungan di atas merupakan nilai konsentrasi
dengan waktu pengukuran 1 jam. Untuk dapat dilakukan perbandingan
dengan nilai baku mutu udara ambien yang berlaku maka harus dikonversi
terlebih dahulu agar didapat nilai pendekatan konsentrasi TSP untuk waktu
pengukuran 24 jam. Persamaan konversi Canter menggunakan persamaan
(8) di bawah ini:
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cli=c2 (g)p .............................................................. (4)

Keterangan:

Ci = Konsentrasi yang setara dengan konsentrasi TSP di udara
dengan waktu pengukuran 24 jam (ug/m?3)

C2 = Konsentrasi TSP di udara dengan waktu pengukuran
selama 1 jam (ug/md)

ta = Waktu pengukuran selama 24 jam

t2 = Waktu pengukuran saat dilakukan pengambilan sampel

p = Faktor konversi dengan nilai 0,159.

1.6.9 Uji Statistik

Uji statistik yang dilakukan adalah uji Paired T-Test, uji normalitas dan uji
korelasi menggunakan aplikasi SPSS 22.

1. Uji Paired T-Test merupakan uji parametrik yang dapat digunakan pada
dua data berpasangan. Tujuan dari uji ini adalah untuk melihat apakah
ada perbedaan rata-rata antara dua sampel yang saling berpasangan
atau berhubungan. Karena berpasangan, maka data dari kedua sampel
harus memiliki jumlah yang sama atau berasal dari sumber yang sama.
Setelah diketahui hasil dari uji “t” maka dapat disimpulkan hasil dengan
mengacu pada dasar-dasar pengambilan keputusan dalam uji Paired
Sample T-Test yaitu, sebagai berikut (Haryanti dkk., 2021):

a. Jika nilai signifikansi (Sig.) (2-taitel) < 0,05, maka HO ditolak dan
Ha diterima.

b. Jika nilai signifikansi (Sig.) (2-taitel) > 0,05, maka HO diterima dan
Ha ditolak.

2. Uji normalitas merupakan uji untuk menentukan apakah data yang
diperoleh berdistribusi normal atau tidak normal sehingga pemilihan
statistik dapat dilakukan dengan tepat. Uji normalitas pada program
SPSS dapat dilakukan menggunakan uji Kolmogorov dan uji Shapiro-
Wilk. Pengambilan kesimpulan dalam hasil uji normalitas yaitu:

a. Jika nilai signifikansi (Sig.) (2-taitel) > 0,05, maka data dinyatakan
berdistribusi normal

b. Jika nilai signifikansi (Sig.) (2-taitel) < 0,05, maka data dinyatakan
berdistribusi tidak normal.

Dalam uji normalitas dengan jumlah sampel <50 maka disarankan

menggunakan uji normalitas cara Shapiro-Wilk karena memiliki tingkat

sensitifitas yang tinggi untuk mendeteksi sebaran data yang tidak normal

pada data yang kurang dari <50.

3. Uji korelasi digunakan untuk menentukan keeratan hubungan antara
dua atau lebih variabel berbeda yang digambarkan dengan ukuran
koefisien korelasi. Koefisien korelasi merupakan koefisien yang
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menggambarkan kedekatan hubungan antara dua atau lebih variabel.
Korelasi pearson berada di antara -1 hingga 1 dimana jika bernilai positif
maka hubungan itu menunjukkkan searah dan bersifat bertambah, dan
sebaliknya jikalau bernilai negatif maka menunjukkan hubungan searah
akan dan Dbersifat berkurang. Untuk tingkat keeratan dapat
dideskripsikan ,seperti tabel berikut:

Tabel 2. Tingkat Keeratan Korelasi

Interval Koefisien Keeratan Korelasi
0,00 - 0,20 Sangat lemah
0,21-0,40 Lemah
0,41-0,70 Moderat/sedang
0,71-10,90 Kuat
0,91 - 0,99 Sangat Kuat

1 Korelasi sempurna

Sumber: Nugroho, (2005)
Pengambilan kesimpulan dalam hasil uji korelasi yaitu:
a. Jika nilai signifikansi (Sig.) (2-taitel) > 0,05, maka data dinyatakan
tidak memiliki korelasi.
b. Jika nilai signifikansi (Sig.) (2-taitel) < 0,05, maka data dinyatakan
memiliki korelasi.

1.6.10 Alat High Volume Air Sampler (HVAS)

Berdasarkan SNI 19-7119.3-2005 tentang Udara Ambien — Bagian 3: Cara
Uji Partikulat menggunakan Peralatan High Volume Air Sampler (HVAS) dengan
Metode Gravimetri, HVAS merupakan peralatan yang digunakan untuk
pengumpulan kandungan partikel melalui filtrasi sejumlah besar volume udara
di atmosfer dengan memakai pompa vakum kapasitas tinggi, yang dilengkapi
dengan filter dan alat ukur serta kontrol laju alir. HVAS bekerja dengan
penghisap udara yang ada disekitarnya dan menangkap partikel dengan
menggunakan filter pada lapisan atas, filter yang digunakan sebelumnya telah
ditimbang, sehingga diketahui berat filter kosong tanpa sampel yang
terperangkap didalamnya. Bagian penutup HVAS paling atas merupakan
tutupan alat seperti atap rumah yang menjaga filter dari air hujan dan mencegah
masuknya pertikel yang terlalu besar. Ukuran pertikel yang terkumpul
dipengaruhi oleh arah angin disekitar lokasi pengambilan sampel, salah satu
modifikasi yang biasanya dilakukan adalah dengan memanfaatkan ukuran filter
tertentu sehingga hanya partikel dengan ukuran tertentu saja yang dapat
terkumpul didalamnya (Sodikin, 2020).

Prinsip kerja dari High Volume Air Sampler adalah menarik udara bebas
menggunakan pompa melalui suatu inlet yang memiliki ukuran tertentu
sehingga hanya partikulat yang memiliki ukuran yang sesuai atau lebih kecil
yang dapat melaluinya. Setelah melalui inlet tersebut, partikulat akan menempel
pada kertas filter. Laju alir udara dijaga 1200 L/menit selama 24 jam periode
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pengukuran. Partikulat di permukaan filter kemudian ditimbang dengan
timbangan dalam ruangan bersuhu 15-27°C dan kelembaban 0-50% (Zahra dkKk,
2022).
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BAB I
METODE PENELITIAN

2.1 Rancangan Penelitian

Penelitian ini diawali dengan melakukan tinjauan literatur dan penelitian-
penelitian terdahulu yang nantinya dijadikan sebagai acuan dalam pelaksanaan
penelitian. Setelah itu, dilakukan identifikasi dan perumusan masalah,
penentuan titik sampling, serta pengumpulan data primer dan data sekunder.
Penelitian ini merupakan jenis penelitian kuantitatif, dimana data yang diperoleh
dari pengukuran langsung seperti pencemaran udara, volume kendaraan, dan
data metereologi dianalisis. Penelitian ini menghasilkan data tingkat konsentrasi
Total Suspended Particulate pada ruas jalan Letjen Hertasning. Penelitian ini
menggunakan alat High Volume Air Sampler pada setiap interval berdasarkan
SNI SNI 7119-3:2017. Tahapan-tahapan dalam penelitian ini dapat dilihat pada

gambar di bawabh ini:
‘ Mulai ’

v

I Kajian Pustaka |
v

I Pengambilan Data |

v 4

I Data Primer I I Data Sekunder I
. ,
I Volume Kendaraan ] IKonsentrasE TSP I l Data Metereclogi I | Lokasi Pengukuran ]

Y

A
l Analisis Data l
v
| Uji Statistik I
y

A
| Kesimpulan |
Y
‘ Selesai ’

Gambar 1. Bagan Alir Penelitian
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2.2 Waktu dan Lokasi Penelitian

Pengukuran dilaksanakan di Jalan Letjen Hertasning, Kota Makassar pada
tanggal 31 Juli 2024, 1 Agustus 2024 dan 5 Agustus 2024. Pengukuran dilakukan
pada 9 titik lokasi. Penentuan titik lokasi berdasarkan SNI 19-7119.9-2005
tentang penentuan lokasi pengambilan contoh uji pemantauan kualitas udara
roadside. Selain itu, penentuan titik lokasi juga mempertimbangkan pertigaan,
perempatan dan arah putar balik dominan. Tipe Jalan Letjen Hertasning yaitu 6/2
UD (enam-lajur dua arah dengan median). Jalan ini memiliki bahu jalan dengan
lebar 2,10 m, lebar jalan 15,4 m, tinggi median 0,15 m dan panjang jalan sebesar
2,753 m. Lokasi pengukuran dapat dilihat pada gambar di bawah ini:

PRPAEERMAY TR IR LIVCAL A
LI »

Taw FTAm
AV

AL e == L

TR

A TR RTIA
ARALII TERGALT WSS T AN
VHICAE W SPYNIIS PARTIOVATE (T
PO R A NS EEIES BERT AT
™

Gambar 2. Lokasi Pengukuran

Pengukuran TSP menggunakan alat High Volume Air Sampler
berdasarkan SNI 7119-3:2017 tentang cara uji partikel tersuspensi total
menggunakan peralatan High Volume Air Sampler (HVAS) dengan metode
gravimetri. Pengukuran TSP dilakukan selama 3 interval dengan masing-masing
interval selama 1 jam. Waktu dan titik lokasi pengukuran dapat dilihat pada tabel

di bawabh ini:
Tabel 3. Waktu dan Titik Lokasi Pengambilan Data TSP
Lokasi Lokasi Interval Pagi Interval Siang Inrerval Sore
- Sf::n'[;”dgaﬁ'g;":na Pukul 07.00 -  Pukul 11.00-  Pukul 16.00 -
P 08.00 12.00 17.00

Bank BRI
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Lokasi Lokasi Interval Pagi Interval Siang Inrerval Sore

T2 Samping kiri Raja Pukul 08.15 — Pukul 12.15 - Pukul 17.15 -
Buah 09.15 13.15 18.15

T3 Depan Apotek Pukul 09.30 - Pukul 13.30 - Pukul 18.30 -
Bersaudara 10.30 14.30 19.30

T4 Depan Klinik PLN Pukul 07.00 - Pukul 11.00 - Pukul 16.00 -
Panakkukang 08.00 12.00 17.00

5 Depan PLN (Persero) Pukul 08.15 - Pukul 12.15 - Pukul 17.15 -
Wilayah Sul-Sel 09.15 13.15 18.15

T6 Samping Sangir Pukul 09.30 - Pukul 13.30 - Pukul 18.30 -
Talaud 10.30 14.30 19.30

T7 Samping Es Teler Pukul 07.00 - Pukul 11.00 - Pukul 16.00 -
Durian 08.00 12.00 17.00

. . Pukul 08.15 - Pukul 12.15 - Pukul 17.15 -
T8 Samping BFI Finance 09.15 13.15 18.15

T9 Samping Sinar Pukul 09.30 - Pukul 13.30 - Pukul 18.30 -
Galesong Mandiri 10.30 14.30 19.30

Berikut gambar titik lokasi pengukuran polutan TSP sebagai berikut:
Titik 3

Titik 1

Titik 2
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Titik 4

Gambar 3. Titik Lokasi Pengukuran
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Berikut sketsa pengambilan data TSP sebagai berikut:

—— e w—  s—

ALk

JALLR

e W TIE
® -

e

. - Apk Wiardy

T-.‘ = Spevd Gun

Gambar 4. Sketsa Pengambilan Data TSP
2.3 Bahan Uji dan Alat
2.3.1 Bahan Uji

Adapun bahan yang digunakan dalam pengukuran polutan TSP yaitu
kertas saring Whattman GF/A Glass Microfiber Filters.

2.3.2 Alat

Pengukuran ini menggunakan alat-alat yang dapat dilihat pada
gambar berikut ini:




2.4

o Q -
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Gambar 5. Alat Pengukuran

Windy app berfungsi untuk mengukur tekanan udara, suhu, kelembaban,
arah angin, dan curah hujan.

Timbangan analitik berfungsi untuk menimbang kertas filter

Payung berfungsi untuk melindungi alat dari panas matahari

Stopwatch berfungsi untuk mengukur lamanya waktu selama melakukan
pengukuran

Tripod berfungsi berfungsi untuk tempat dudukan alat HVAS dan weather
station

Roll Meter berfungsi untuk sumber aliran listrik

Traffic Counter berfungsi untuk menghitung volume kendaraan

Kertas Filter berfungsi untuk menyaring partikel yang ada di udara ambien
High Volume Air Sampler berfungsi untuk menghisap partikel yang
terakumulasi dalam filter

Teknik Pengumpulan Data

Metode pengumpulan data dilakukan dengan menggunakan data
primer dan data sekunder. Data primer yang dibutuhkan dilakukan dengan
pengukuran secara langsung di lapangan yaitu tingkat konsentrasi TSP,
volume kendaraan, data metereologi. Data sekunder yang dibutuhkan yaitu
peta lokasi menggunakan google earth. Volume kendaraan diperoleh
dengan cara melakukan perhitungan jumlah kendaraan dengan
menggunakan aplikasi traffic counter selama satu jam pengukuran. Data
metereologi  diperoleh dengan menggunakan aplikasi windy.app.
Pengukuran TSP dilakukan dengan menggunakan alat High Volume Air
Sampler. Berikut langkah-langkah pengambilan data polutan TSP di
lapangan:



21

2.4.1 Metode Pengambilan Data TSP

( Mulai )

Menyiapkan alat dan bahan

A. Bahan

1. Filter Fiber Glass
B. Alat

1. Tripod

2. Pinset

3. HVAS

4. Payung

\4

Menyusun semua peralatan pengambilan sampel dan menempatkannya
pada posisi dan lokasi pengukuran yang telah ditetapkan berdasarkan
metode penentuan lokasi pengambilan contoh uji pemantauan udara
ambien sesuai SNI 7119.3-2017

Menempatkan filter pada filter holder

\ 4

Menghubungkan alat TSP dengan sumber daya listrik

\4

Menghidupkan alat HYAS kemudian mengatur kecepatan alir sebesar 0,5
I/menit dan memantau laju alir tiap 3 menit sekali, melakukan
pemantauan selama 1 jam

Mematikan alat TSP setelah 1 jam pengukuran

\ 4

o
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Mengeluarkan kertas saring dan memasukkannnya ke dalam aluminium

foil

A 4

( Selesai )

Gambar 6. Diagram Alir Pengambilan Data TSP

2.4.2 Metode Pengambilan Data Volume Kendaraan

1 Mulai )

\ 4

Menyiapkan alat yang akan digunakan:

1.

2.
3.
4

Alat tulis

Stopwatch

Aplikasi Traffic Counter
Form penelitian

Menekan volume kendaraan menggunakan aplikasi Traffic Counter

Y

Mencatat hasil pengukuran volume kendaraan pada form penelitian

\ 4

1 Selesai )

Gambar 7. Diagram Alir Pengambilan Data Volume Kendaraan
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2.4.3 Metode Pengambilan Data Metereologi

1 Mulai )

A4

Menyiapkan alat yang akan digunakan:
1. Alat tulis

2.
3. Aplikasi Windy App
4,

Stopwatch

Form penelitian

A 4

Membuka aplikasi Windy kemudian memilih titik lokasi pengukuran
setelah itu memilih waktu pemantauan cuaca interval satu jam

A4

Memantau cuaca selama satu jam pengukuran tiap tiga menit sekali

25

A\ 4

( Selesai )

Gambar 8. Diagram Alir Pengambilan Data Metereologi

Teknik Analisis

Analisis data dilakukan dengan metode Gravimetri menggunakan
timbangan analitik untuk mengetahui tingkat konsentrasi TSP pada ruas
Jalan Letjen Hertasning. Teknik analisis dilakukan dengan pendekatan
kuantitatif. Dari hasil pengukuran akan dilakukan perhitungan menggunakan
persamaan 1, 2, 3 dan 4 berdasarkan SNI 7119-3:2017. Setelah didapatkan
hasil dari perhitungan selanjutnya akan diuji statistik yaitu uji Paired Sample
T-Test antara hasil yang didapatkan setiap interval untuk melihat perbedaan
konsentrasi yang didapatkan selama pengukuran dan uji korelasi pearson
untuk mengetahui hubungan antara volume kendaraan yang melewati titik
pengukuran dengan konsentrasi TSP yang dihasilkan dan hubungan data
metereologi dengan konsentrasi TSP selama pengukuran.
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Penimbangan Kertas Saring Awal

( Mulai }

A\ 4

Menyiapkan alat dan bahan yang akan digunakan:

A. Bahan

1. Filter Fiber Glass
B. Alat

1. Pinset

2. Cawan Petri
3. Timbangan analitik

A4

Menyalakan timbangan analitik dan memasukkan cawan petri ke dalam
timbangan analitik untuk dikalibrasi

Memasukkan 1 lembar filter fiber glass menggunakan pinset ke dalam
cawan petri yang ada di dalam timbangan analitik kemudian menutup
timbangan analitik

A4

Mengukur berat cawan petri yang berisi filter fiber glass dan mencatat hasil
yang muncul pada timbangan analitik sebagai berat filter awal

A4

Mematikan timbangan analitik dan mengeluarkan cawan petri dari
timbangan analitik

A4

Memasukkan kertas filter ke dalam aluminium foil untuk dibawa ke
lokasi pengukuran

A 4

( Selesai )

Gambar 9. Diagram Alir Penimbangan Kertas Saring Awal




25

2.5.2 Penimbangan Kertas Saring Setelah Pengukuran

Setelah melakukan pengukuran di lapangan, maka data yang
diperoleh akan dianalisis. Adapun tahapan analisis data dapat dilihat

pada diagram alir di bawah ini:

1 Mulai )

Menyiapkan alat dan bahan
A. Bahan
1. Filter Fiber Glass
B. Alat
1. Pinset
2. Timbangan analitik
3. Cawan petri

v

Mengeluarkan filter fiber glass dari aluminium foil menggunakan pinset

'

Menyalakan timbangan analitik dan memasukkan cawan petri ke dalam
timbangan analitik untuk dikalibrasi

\4

Memasukkan filter fiber glass menggunakan pinset ke dalam cawan
petri yang ada di dalam timbangan analitik kemudian menutup
timbangan analitik

Mencatat berat cawan petri yang berisi filter fiber glass kemudian
mencatat hasil yang muncul

A\ 4

o
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Mengeluarkan cawan petri dan filter fiber glass dari timbangan analitik

A

Mematikan timbangan analitik kemudian merapikan semua peralatan
yang digunakan

Gambar 10. Diagram Alir Penimbangan Kertas Saring Setelah
Pengukuran

1 Mulai )

A 4

2.5.3 Pengolahan Data TSP

Memasukkan data hasil pengukuran ke dalam Microsoft Excel

l

Melakukan perhitungan konsentrasi TSP (Persamaan 1,2,3 dan 4)

\4

Menyajikan hasil perhitungan konsentrasi TSP dalam bentuk diagram

Gambar 11. Diagram Alir Pengolahan Data TSP
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2.5.4 Uji Statistik

Adapun langkah-langkah melakukan uji Paired Sample T-Test

dalam program SPSS adalah sebagai berikut:

1.
2.
3.

4,

Menginput data yang akan dianalisis

Klik Analyze>Compare Means>Paired Sample T-Test

Selanjutnya akan muncul kotak dialog dengan nama Paired Sample T-

Test, pindahkan data yang akan diuji pada masing-masing kolom

variabel

Kemudian klik OK, maka hasil pada output program SPSS akan muncul
Adapun langkah-langkah melakukan uji normalitas dalam program

SPSS adalah sebagai berikut:

Nooos~wNPE

Menginput data yang akan dianalisis

Klik Analyze>Descriptive Statistisc>Explore

Masukkan data yang akan diuji dalam Dependent List

Klik menu Options>Exclude cases listwise>Continue

Klik menu Statistics>Descriptive>Continue

Klik Plots kemudian centang Normality Plots With Tests

Kemudian klik OK, maka hasil pada output program SPSS akan muncul
Adapun langkah-langkah melakukan uji korelasi pearson dalam

program SPSS adalah sebagai berikut:

1.
2.
3.

Menginput data yang akan dianalisis

Klik Correlate>Bivariate

Selanjutnya akan muncul kotak dialog dengan nama  Bivariate
Correlation, pindahkan data yang akan diuji pada masing-masing kolom
variabel

Kemudian klik OK, maka hasil pada output program SPSS akan muncul



